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Lesson #1 

Lesson’s overview

Tsunami evacuation zone mapping

● Cannes area 

● Presentation of the selected 
approach for evacuation 
area definition in France

● Pro and cons 

1. Theory 2. Practice

● Extract the altitude range 
set from numerical 
modelisation using DEM and 
GIS

● Corrections needed for a 
coherent evacuation zone 

● Derivate safe zone
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Use of a DEM to map a “standardized” inland tsunami evacuation zone.
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Mapping Tsunami Evacuation Zones: 4 Key Methods
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● Different methods exist to map tsunami 
danger zones

● The choice depends on data availability, local 
knowledge, and technical capacity

● Methods range from advanced simulations to 
basic elevation-based approaches

● Each method offers trade-offs in precision, 
effort, and accessibility
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Definition
This method combines the results of several validated tsunami simulations to produce a single envelope 
representing the maximum potential inundation.

Applications

● High-exposure coastal zones
● Critical infrastructure (ports, airports, energy sites)

Strengths

● Conservative and robust
● Detailed outputs for maximums : wave arrival time,

water depth, flow speed
● Integrates uncertainty from different scenarios
● Ideal for long-term planning and zoning

Limitations

● Requires multiple simulations
● High technical and financial cost
● Not always feasible for small territories

Christopher P. Hood
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Mapping Tsunami Evacuation Zones - 2 : Hydrodynamic Modelling (Single Scenario)

Definition

Numerical simulation of tsunami generation, propagation, and inundation for one predefined scenario (often the 
worst-case plausible event).

Applications

● High-exposure coastal zones
● Critical infrastructure (ports, airports, energy sites)

Strengths

● Physically accurate and scenario-specific
● Detailed outputs: wave arrival time, water depth, flow speed
● Helps visualize and communicate local risk
● Ideal for long-term planning and zoning

Limitations

● Requires multiple simulations
● Only reflects one event configuration
● May miss other potential threat sources Pablo Poulain et al, 2022
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Mapping Tsunami Evacuation Zones - 3 : Topographic Projection from Simulated Coastal Heights

Definition

Inundation zones are derived by projecting simulated maximum wave heights onto land, using a 
Digital Elevation Model (DEM). No inland flood modelling is performed.

Applications

● Territories with access to tsunami simulations but limited modelling capacity
● Easier to generalize over large coastal areas
● Suitable for regional-scale evacuation planning

Strengths

● Uses outputs from actual tsunami scenarios
● Faster and less costly than full inundation models
● Requires fewer computational resources

Limitations

● Still needs accurate input data (DEM, coastal wave heights)
● Doesn’t account for local hydrodynamics (flow, obstacles, direction)
● May overestimate or underestimate extent in flat or complex terrain
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Mapping Tsunami Evacuation Zones - 4 : Simple Elevation-Based Method ("Bathtub")

Definition

Tsunami danger zones are mapped using a fixed elevation threshold (e.g. 10–15 m), without relying on simulation 
outputs. It is also recommended to set a maximum inland penetration distance, to avoid unrealistic inland extents in flat 
terrain.

Applications

● Territories with no access to tsunami modelling
● Useful for early-stage planning and awareness
● Can be applied using basic topographic data (DEM)

Strengths

● Requires no simulation
● Easy to implement and to communicate to the public
● A good starting point for evacuation planning

Limitations

● May overestimate inland extent
● No information on wave dynamics or timing

● Assumptions must be validated by risk management authorities
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An Operational Choice

● Evacuation planning in France began with the Simple Elevation-Based Method (10 m threshold)

● Selected due to the lack of usable simulation data and the need for consistency across territories

● Informed by international practices, historical runup values, and partial modelling outputs

Progressive National Deployment

● Method first used in the French Antilles (2013–2014)

● Then adapted and applied in the Mediterranean 
(2019) under the TASOMA project

● Finally adopted in Mayotte (2020) as a starting point 
for tsunami preparedness

A simple, shared method has 
enabled nationwide progress in 
tsunami evacuation planning, 

despite data gaps and regional 
diversity.
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Overview of the theoretical stages
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https://arcg.is/1vfGSz

Using this method, we were 
able to map the evacuation 
zone for the entire coastline 

in around a month during the 

TASOMA Project 
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1. For the past year, awareness-raising activities (public meeting, meeting in schools) have been carried out locally, in particular in 
collaboration with CENALT and DGSCGC.

2. Discussions within the national Tsunami working group have led to recommendations that have been validated at the national level.
3. A scientific partnership with the University Paul-Valéry Montpellier 3, has enabled the design of standardised evacuation plans and 

tsunami signage according to a method already deployed in the French West Indies (Caribbean sea) 

"The taking into account of the 
Tsunami hazard in Cannes is 
part of a strong political will 
initiated since 2015 for a 
concerted management of 
natural risks and a better 
awareness of citizens".

City of Cannes evacuation challenges in case of tsunami alert …
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GIS detailed overview 
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varies between countries. 
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Resolution 5m Resolution 1m

Cons
- Slow to process 
- 1m res DEM cannot be used 

for a whole region on most 
computer.

Pro
- Better accuracy for terrain 

with significant altitude 
variation

- High resolution evacuation 
zone

Programme national LiDAR HD : 

https://geoservices.ign.fr/lidarhd

Université Montpellier Paul Valéry - LAGAM    Dr. Matthieu Péroche (matthieu.peroche@univ-montp3.fr) - Louis Monnier 

Tsunami evacuation zone mapping

mailto:matthieu.peroche@univ-montp3.fr


Lesson #1 Mapping the evacuation zone Coastwave 2.0 Evacuation 
Mapping Workshop 

16

Lesson’s data

Required layers for the lesson

Processed layers

Results
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Resolution 30m
● Shuttle Radar Topography Mission (SRTM) - 

https://dwtkns.com/srtm30m/

● Copernicus DEM - Global and European Digital Elevation Model

https://dataspace.copernicus.eu/explore-data/data-collections/copernicu

s-contributing-missions/collections-description/COP-DEM

Cons
- Low evacuation zone 

precision  
- Not suitable on terrain with 

significant altitude variation 

30m resolution DEM with a world coverage are largely available in open access. 

Pro
- Fast to process 
- Suitable for large studie’s 

area (country)
- World coverage

Resolution 1m
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Cannes

Each pixels in the image have a pixel elevation 
value “LAYER_NAME” <= 5 Pixel’s value is now “0” or “1” depending if 

the pixel elevation value matched the 
condition or not.

0

1
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The previous raster’s pixel values are in the field 
“gridcode”.
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Isolated 
polygon 

Polygon’s 
edges need 

simplification

local variations 
in altitude 

must be 
deleted

we obtain a polygon with a very 
precise level of detail that leads to 
several geometries to be 
generalized
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Isolated 
polygon 

Polygon’s 
edges need 

simplification

local variations 
in altitude 

must be 
deleted

we obtain a polygon with a very 
precise level of detail that leads to 
several geometries to be 
generalized

Before this step, we need to  take into account the 
initial assumptions regarding maximum distances 
inland and around watercourses.
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Only open-air hydrographic network will be taken into account for the evacuation zone
⇒ During field mission or trough aerial image interpretation 

Non cased drainage Cased drainage
24
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Generate 500 meters buffer on clipped coastline
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Map (Ribbo) > Select by location 
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Map (Ribbo) > Select by location 

Clip watercourse with previous buffer
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Map (Ribbo) > Select by location 

Merge both watercourse & coastline 
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Generate 200 meters buffers with the merged layer and export the result as “evacuation_zone_constraints”

 

The result is our initial hypothesis constraints

Université Montpellier Paul Valéry - LAGAM    Dr. Matthieu Péroche (matthieu.peroche@univ-montp3.fr) - Louis Monnier 

Tsunami evacuation zone mapping

mailto:matthieu.peroche@univ-montp3.fr


Lesson #1 Mapping the evacuation zone Coastwave 2.0 Evacuation 
Mapping Workshop 

Université Montpellier Paul Valéry - LAGAM    Dr. Matthieu Péroche (matthieu.peroche@univ-montp3.fr) - Louis Monnier 
29

Tsunami evacuation zone mapping

mailto:matthieu.peroche@univ-montp3.fr


Lesson #1 Mapping the evacuation zone Coastwave 2.0 Evacuation 
Mapping Workshop 

30

Clip the RGEAlti_0_5m on the evacuation_zone_constraints layer. 

Université Montpellier Paul Valéry - LAGAM    Dr. Matthieu Péroche (matthieu.peroche@univ-montp3.fr) - Louis Monnier 

Tsunami evacuation zone mapping

mailto:matthieu.peroche@univ-montp3.fr


Lesson #1 Mapping the evacuation zone Coastwave 2.0 Evacuation 
Mapping Workshop 

31

Clipping the RGEAlti_0_5m with 
the constraints polygon provide 
us a raw version of the 
evacuation zone which will be 
used to create the final tsunami 
evacuation zone.

Corrections are needed at this 
point : 

1. Removing off-lands parts
2. Removing holes due to local 

elevation change
3. Removing parts not 

connected with the sea
4. Smoothing the polygon’s 

edges
5. Removing small inhabited 

islet

Université Montpellier Paul Valéry - LAGAM    Dr. Matthieu Péroche (matthieu.peroche@univ-montp3.fr) - Louis Monnier 
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Erosion & Dilation on Vector Data

Buffer the 
“evacuation_zone” 
layer by 10 meters 
to smooth and 
connect isolated 
depressions.
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Erosion & Dilation on Vector Data

Buffer the 
“evacuation_zone” 
layer by -10 meters 
to simplify the 
geometry and 
eliminate narrow 
connections.
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Erosion & Dilation on Vector Data

Cleaned geometry 
and simplified 
outlines
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The Eliminate Polygon Part geoprocessing tool allows holes larger than the minimum hole size parameter
→ The result of the algorithm can vary significantly depending on the input parameters.
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The Eliminate Polygon Part geoprocessing tool allows holes larger than the minimum hole size parameter
→ The result of the algorithm can vary significantly depending on the input parameters.

Select Inverse selection

Delete and save changes
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Polygon Smoothing for Clearer Boundaries

Smooth the evacuation_zone 
layer to reduce angular 
shapes and improve boundary 
readability.
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Removing off-land parts by 
clipping the layer with Cannes 
boundaries polygon. 

→ Clipping the layer with coastline 
is also possible if the communitie’s 
boundaries aren’t accurate along 
the coast. 

If so, generate a polygon using a 
high resolution coastline and the 
edges of your work area
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Make sure that the result of the clipping operations is conform to our initial hypothesis (0-5m high & 200m inland or 500m 
inland near watercourses that are connected to the sea)
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Field verification is mandatory in order to detect 
errors or the need for local adaptations that 
cannot be assessed through imagery analysis.

E.g : Cap 3000, Nice’s metropole’s largest mall

Due to the large numbers of visitors, the 
authorities decided to make an exception to the 
standard evacuation instructions for this 
shopping center : people already in the mall will 
have to stay inside.

Field visit allowed to take into account the 
recently constructed seafront terrace that 
wasn’t available on satellite imagery at the 
beginning of the project. 

The evacuation zone along the mall was 
modified based on the field verification and 
up-to-date Lidar data 

Lidar’s 0-5m range extraction (in red)

Université Montpellier Paul Valéry - LAGAM    Dr. Matthieu Péroche (matthieu.peroche@univ-montp3.fr) - Louis Monnier 

Tsunami evacuation zone mapping

mailto:matthieu.peroche@univ-montp3.fr


Lesson #1 Mapping the evacuation zone Coastwave 2.0 Evacuation 
Mapping Workshop 

41

Generate the tsunami safe zone ! 
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Tsunami evacuation zone mapping

Use the Symmetrical difference tool between the evacuation zone and Cannes boundaries to 
generate the safe zone   

Université Montpellier Paul Valéry - LAGAM    Dr. Matthieu Péroche (matthieu.peroche@univ-montp3.fr) - Louis Monnier 

mailto:matthieu.peroche@univ-montp3.fr


Tsunami Evacuation 
Mapping Workshop

CoastWAVE 2.0 Project 

IOC-UNESCO (EU DG ECHO)

Dr. Matthieu Péroche
Louis Monnier

Contact :  matthieu.peroche@univ-montp3.fr

30 June – 4 July 2025



Tsunami Evacuation 
Mapping Workshop

CoastWAVE 2.0 Project 

IOC-UNESCO (EU DG ECHO)

30 June – 4 July 2025

Dr. Frédéric Leone
Dr. Matthieu Péroche

Louis Monnier

Contact :  matthieu.peroche@univ-montp3.fr

Lesson #2
Method for identifying tsunami 
assembly points



Lesson #2 

Lesson’s overview

Method for identifying tsunami assembly points

1. Theory 2. Practice

● Mapping the entry points in the 

safe zone

● Assembly point 

pre-identification

● Field inspection & quality 

assessment 

● Deliverable

 

Coastwave 2.0 Evacuation 
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● Selection criteria

● Authorities validation 
process
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Why define tsunami assembly points?

● To give people a clear direction and a 
specific place to reach

● To identify and communicate the 
location both on maps and on the 
ground

● To help emergency services locate and 
regroup the population

● To encourage evacuation on foot to a 
safe and suitable area
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Site refuge verticaux Site refuge horizontauxVS

https://www.fema.gov/sites/default/files/document
s/fema_rsl_guidelines-for-design-of-structures-for
-vertical-evacuation-from-tsunamis_050925.pdf

Horizontal Refuge Vertical Refuge

Definition Outdoor safe zone located outside 
the inundation area

Elevated structure (e.g. tall building or 
tower) designed to resist tsunami forces

Used in our 
studies?

✅ Yes, systematically ❌ No

Horizontal vs. Vertical Tsunami Assembly Points

Why ?

● Safer in seismic contexts (no risk of collapse)
● Easily identifiable and accessible
● No structural evaluation required
● Requires strict engineering standards (e.g. FEMA guidelines)
● Risk if structure is not designed/tested
● Complex legal and technical validation 

In French territories, walking short 
distances to safe areas is usually 

sufficient — horizontal evacuation is 
both feasible and safer in our context.
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Modelled distant tsunami sources and effects of the 2004 tsunami in Mayotte
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Several potential local sources linked to the seismic-volcanic activity of a new submarine volcano named Fani 
Maoré (May 2018)
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Models show low amplitudes along the coast (1 to 2 m) but a very short travel time

Modeling of a tsunami triggered by slope instability off the coast of 
Petite-Terre (R. Pedreros)

The east coast of Petite-Terre remains the most 
exposed to the effects of a tsunami (close sources 
and absence of protective reefs).

The models generate local water level rises of 
more than one meter, resulting in surges of 
several meters on the coast.

The scenarios modeled for the east of Petite-Terre 
show very short arrival times for the waves on the 
coast, ranging from a few minutes in the east of 
Petite-Terre to around 18 minutes for the east 
coast of Grande-Terre.

> Be prepared for a phenomenon that is 
moderate in amplitude but can arrive very 
quickly.
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Search areas for refuge sites

Evacuation zone set between 0 and 5 m altitude in Mayotte
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Pre-survey for eligible refuge sites using aerial imagery and field surveys (August 2020)

Field Research orientation using refuge zone entry points automatically generated in GIS (intersection points between 
isolines and roads : red dots here)

Université Montpellier Paul Valéry - LAGAM    Dr. Matthieu Péroche (matthieu.peroche@univ-montp3.fr) - Louis Monnier 

mailto:matthieu.peroche@univ-montp3.fr


Lesson #2 Method for identifying tsunami assembly points Coastwave 2.0 Evacuation 
Mapping Workshop 

10

12 Criteria for selecting refuge sites (temporary assembly/meeting/refuge places)

> We walked 100 km in three weeks !
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1. The right altitude 

Select topographic 
sites higher than the 
upper limit of 
evacuation zone

But with a safety 
margin of a few meters 
(5 m here) 

> Horizontal 
evacuation

R
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2. The right distance

Ensure that the site is less than a 
15-minute walk (or < 800 m) from 

the evacuation zone

No need to go too high or too far !

 Beyond that, people become 
exhausted or demotivated

< 15 min (< 800 m)

R
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3. A good accessibility

Favor if possible a good accessibility with multiple routes
 

Avoid stairs and narrow passages (unless there is no other choice > mark them on the evacuation plan)

R
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4. A sustainable availability

Check the current and future 
availability of sites 

No construction projects 
planned 

> Check this with the local 
authorities
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5. A secure zone and more…

If possible, choose a secure and safe site, in 
particular with regard to road traffic
or buildings collapse in case of tsunami 
triggered by an earthquake

 
And why not a fully equipped, shaded, with hot and cold 

drinks, and pastis on request!
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6. A strategic view

Preferably with a view of the 
sea
 
Seeing the source of danger is 
one way to track the tsunami 
and the situation
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7. Easy to find

A Public and/or 
well-known site with a 

good reputation
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8. Go higher if need
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9. The right capacity

With adequate capacity 

(less of a problem on road 
sections)

Depending on the areas to be 
evacuated (day, night, rush 
hour, low or high tourist 
season 

> This requires a 
frequentation study
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10. Do not disturb the spirits

A place without cultural 
restrictions

 
(no cemeteries for example)

R
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11. Don't pile on the problems

Avoid exposing the site to 
other natural hazards
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12. Do not disturb…

Always stay away from sensitive 
and strategic locations to manage 
the crisis (police forces, 
firefighters centers, town hall) to 
clear access routes in case of 
emergency.
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Criteria for selecting refuge sites (temporary assembly/meeting/refuge places)

With adequate capacity (less of a problem 
on road sections)

Check the current and future availability of 
sites (no construction planned)

Public and/or well-known site with a 
good reputation

A place without cultural restrictions 
(no cemeteries)

Always offer the possibility of going higher to 
reassure people

If possible, a secure and safe site (in 
particular with regard to road traffic)

Preferably with a view of the sea (seeing the 
source of danger is one way to track the 

tsunami)

Favor if possible a good accessibility with 
multiple routes 

Avoid stairs and narrow passages

Topographic sites higher than the upper 
limit of evacuation zone 

But with a safety margin of a few meters 
(5 m) > Horizontal evacuation

Less than a 15-minute walk (or < 800 m) from the 
evacuation zone 

(No need to go too high or too far !)

Always stay away from sensitive and strategic 
locations to manage the crisis

Avoid exposing the site to other natural 
hazards
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Validation levels and process for refuges sites

Depending on the target territory, its territorial organization, levels of competence, and levels of responsibility

1. Community via an ad hoc committee with :
• Local elected officials (mayor, deputy mayors)
• Municipal technical services (DGS)
• Fire department
• Municipal police
• Representative of state services
• Others (population via associations, elected representatives of the local community)
• And ourselves as researchers !

2. Government departments in charge of risk and crisis management (here at the 
departmental level)
 > SIDPC (Prefecture) with technical support from DEAL (Department responsible for risk 
management)Principle of 

hierarchical 
bottom-up 
validation

3. Préfet / Senior State Authority (highest representative of the State at the departmental 
level, appointed by the government, guarantor of public service, responsible for 
administrative control and enforcing State policy)

Mayotte
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Participatory validation of refuge sites in each of the 16 coastal municipalities (January 2021)

Session schedule (2 to 3 hours):

• Presentation of the context (risks, challenges, 
evacuation)

• Questions and answers
• Practical exercises on screen and then in the 

field

Objectives:

✔ Check the suitability of the site
✔ Move, delete, or add to it
✔ Look at possible developments
✔ Test certain routes
✔ Name it
✔ Validate the site

> 90 people met and involved in the process
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Final validation and presentation to the public (press conference)

> 216 shelters approved by the Prefect in October 
2021 (14 months after the first field surveys)

> 87 plans edited (16 communes)
> 3 prevention videos
> 1 website internet and more…

Launch of the official preventive information 
campaign by the Prefect on October 20, 2021, and 
inauguration of the EVACTSU project website
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Website with interactive map
https://arcg.is/1be4iC0
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1. Use QuickOSM in QGIS : 
○ Key : highway
○ Value : all

2. Discard non-linear features

● For more info on data’s values : 
https://wiki.openstreetmap.org/wiki/Map_features#Highway

Download road’s network 
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Safe zone entry points

Use the intersect geoprocessing tool to generate 
point on intersections between roads features 
and the evacuation zone.
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Safe zone entry points

Due to intersecting geometry between in 
some areas (port, levees, dock), 
irrelevant points features can be 
generated.

Remove them before saving the layer 

Select the irrelevant points feature and delete them : 

1. Top ribbon > Edit > Select 

2. Top ribbon > Features > Delete
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Assembly points pre-identification

Create a temporary_assembly_points layer : 

1. Top ribbon > View > Catalog Panel
2. Catalog panel > Project > Databases > “project database”
3. Right click > New > Feature Class

4. Name your layer 
5. Set the geometry type
6. Click on Next
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Assembly points pre-identification

1. Set up the fields in the layer’s dataset : 

Create 4 fields and set the Data Type for each field : 

a. ID (Long)

b. NAME (Text)

c. Picture (Text)

d. Type (Text)

2. Set the coordinate system

Create 4 fields and set the Data Type for each field : 

Select RGF 1993 Lambert-93 (EPSG: 2154)

3. Click on Finish

1 2
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Assembly points pre-identification

In order to create new features : 

1. Select temporary_assembly_points in the Contents panel
2. In the Top ribbon > Edit > Create
3. Select the layer in the Create Features panel
4. Select Point
5. Create feature by clicking on the map canvas
6. Toggle the Attributes panel (Top ribbon > Edit > Attributes) 
7. Fill in  the value 

2

1

3

4

6
7

Université Montpellier Paul Valéry - LAGAM    Dr. Matthieu Péroche (matthieu.peroche@univ-montp3.fr) - Louis Monnier 

mailto:matthieu.peroche@univ-montp3.fr


Lesson #2 Method for identifying tsunami assembly points Coastwave 2.0 Evacuation 
Mapping Workshop 

35

Assembly points pre-identification

Identify the 12 most suitable places for assembly points 
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Time for field work 

● Quality assessment for temporary assembly points

● If possible, bring someone with you from your teams and another one 
from the community (technical staff, …)

● Take geotagged photos

● Collect data using GIS mobile application (SW Maps, QField, Fieldmap) 

Université Montpellier Paul Valéry - LAGAM    Dr. Matthieu Péroche (matthieu.peroche@univ-montp3.fr) - Louis Monnier 

mailto:matthieu.peroche@univ-montp3.fr


SW Maps provide all the features needed during the field work :

● Load multiples layers in various formats (kml, shapefile, 
geopackage, etc.) 

● Create layers 

● Symbology management 

● Edit layer’s feature geometry

● Edit layer’s data attributes 

● Link photos with feature

● Measure distance / area

● Record GPS track 
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Field mapping : SW Maps

SW Maps is a free GIS mobile mapping application available for both 
Android and Apple phones.

SW Maps Android User manual : 
https://aviyaantech.com/SwMaps/assets/SW%20Maps%20Manual%
20V3.0.pdf
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Field mapping : SW Maps
SW Maps doesn’t allow to add or remove a layer’s field once it have been imported on the phone. Layer’s field 
configuration must be done in a desktop GIS software. 

Setting up the field beforehand 
allows us to set constraints, 
domains or attachments on 
the field values, making the 
process of filling in data easier, 
and reducing the risk of error.
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Assembly points pre-identification

Experience sharing : the importance of field work
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The most important step in this process is to validate assembly points with the local authorities.

● Present each refuge site

● Discuss the advantages and 
disadvantages of each assembly points

● Improve coverage where it's needed

● Allow to take into account future urban 
change

● Benefit from local knowledge
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The most important step in this process is to validate assembly points with the local authorities.

Supports documents must be produced to give insight during the validation meetings. 
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21 official assembly points in Cannes 
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Lesson #3 

Lesson’s overview

Tsunami evacuation routes calculation using graph-based 
GIS methodology

● Graph’s theory

● Walking pace reference

● Others methods

1. Theory 2. Practice

● Get the data and check 

topological rules

● Field work 

● Specials cases 

● Setting the starting points 

for the analysis

● Lauching the analysis 
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Semi-automatic mapping of tsunami evacuation routes using graph-based GIS tools
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Method 3 – Agent-Based Modeling (ABM) - Simulating behavior on an individual level

● Principle:
Individual-level simulation of the evacuation process. Each agent interacts with its environment and others based on 
predefined rules.

● Required Data:
Behavioral profiles, spatial environment (raster or vector), alert scenarios, infrastructure and obstacles.

● Configurable Parameters:
○ Agent attributes: mobility, delay before action, knowledge of the area
○ Behavior rules: route choice, alert response, social interaction
○ Dynamic environment: congestion, blocked roads, tsunami impact

● Expected Outputs:
○ Individual and collective evacuation times
○ Flow maps, congestion points, critical areas
○ Success rate of evacuation under different alert and management scenarios

✅ Advantages: highly realistic, allows testing of planning and communication strategies

 ⚠ Limitations: complex setup, requires behavioral data and careful calibration

Herrera and al, 2020
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Tsunami evacuation routes calculation using graph-based 
GIS methodology
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Method 2 – Raster-Based GIS: Modelling evacuation with cost surfaces

● Principle:
 Each raster cell is assigned a travel cost; algorithms calculate the least-cost path to a safe zone (cost distance analysis).

● Required Data:
 Digital Elevation Model (slope), land use, road/terrain surface types, restricted areas.

● Configurable Parameters:

○ Multiple parameters (slope, land use, road type) merged into a single cost raster

○ Reclassification of input layers to a common measurement scale

○ Weighting of each criterion based on its impact on travel speed

● Expected Outputs:

○ Minimum evacuation time maps

○ Identification of areas not reachable within safe time limits

○ Scenario comparisons across large and heterogeneous territories

✅ Advantages: flexible, well suited for poorly structured or natural environments
 ⚠ Limitations: accuracy depends on raster resolution; less precise in dense urban settings

https://pro.arcgis.com/en/pro-app/latest/tool-reference/spati
al-analyst/creating-a-cost-surface-raster.htm
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Method 1 – Graph-Based Models: Using networks for strategic planning

● Principle:
 The circulation network (roads, paths, stairs) is modeled as a graph composed of nodes and edges, allowing optimal route calculation 
to safe zones.

● Required Data:
 Road/path network, attributes (slope, surface type, hierarchy), location of safe areas.

● Configurable Parameters:
○ Edge orientation to enforce walking direction
○ Edge costs based on: slope, road hierarchy (width/importance), surface type
○ Travel speed can be weighted by segment characteristics

● Expected Outputs:
○ Shortest or safest evacuation paths
○ Evacuation isochrone maps
○ Identification of bottlenecks and critical segments

✅ Advantages: fast computation, easily readable, suited to urban environments
 ⚠ Limitations: assumes optimal behavior, does not account for human interactions

Université Montpellier Paul Valéry - LAGAM    Dr. Matthieu Péroche (matthieu.peroche@univ-montp3.fr) - Louis Monnier 
5

Sahal, A., F. Leone & M. Péroche. 
« Complementary Methods to Plan Pedestrian 
Evacuation of the French Riviera’s Beaches in 
Case of Tsunami Threat: Graph- and 
Multi-Agent-Based Modelling ». 
Natural Hazards and Earth System Sciences 13, no 7 
(2013): 1735‑43. 
https://doi.org/10.5194/nhess-13-1735-2013. 

Tsunami evacuation routes calculation using graph-based 
GIS methodology

mailto:matthieu.peroche@univ-montp3.fr
https://doi.org/10.5194/nhess-13-1735-2013
https://doi.org/10.5194/nhess-13-1735-2013


Difference between network and graph

Network  Network in graph configuration 

Single line

Multiples vertices 

The single line is 
subdivided in 

multiples edges

Node on every intersection 
between two edges

Depending on your national data providers, 
the transportation network can be already 
configured as a graph.
  
This isn’t the case with OSM data 

Lesson #3 Graph theory & pedestrian network Coastwave 2.0 Evacuation 
Mapping Workshop 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Graph topology

“[...] topology is the arrangement that 
defines how point, line, and polygon 
features share coincident geometry.”

https://pro.arcgis.com/en/pro-app/latest/help/data/topologies/topology-in-arcgis.htm

Eg. Two roads cross at different heights. 

The graph topology rules allow an accurate 
representation of the connectivity between roads in real 
life

Lesson #3 Graph theory & pedestrian network Coastwave 2.0 Evacuation 
Mapping Workshop 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Data preparation
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Generate the starting points for accessibility analysis

Why use a regular grid?

● Ensures homogeneous coverage of the 
evacuation area

● Defines departure points for route 
generation

● Enables spatial analysis and comparison

What can we compute on the grid?

● Evacuation areas

● Evacuation times

● Population and assets to evacuate

● Other geo-indicators for risk and capacity 
assessment
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Generate the starting points for accessibility analysis

Why Use Hexagonal Grids Instead of Squares?

● Equal distance to all neighbors → consistent spatial aggregation

● Avoids directional bias from square grids

● Matches circular influence zones (e.g. audibility, evacuation time)

● Supports natural aggregation of spatial indicators

● Cleaner visual output → smoother, more readable maps

● Uniform shape and size across the study area

● Better spatial aggregation than squares

● No directional bias in spatial patterns

● More natural for computing indicators (density, exposure, 
evacuation time)

● Visually smoother and easier to interpret
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Generate the starting points for accessibility analysis
1. Generate a hexagonal grid covering the evacuation 

zone using the Generate Tessellation tools, then clip 
it two times : with Canne’s administrative boundaries 
and with the evacuation zone.

Select the 
evacuation 
zone layer

Area = 6495 m² 
(50m long edges)
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Human frequentation data is used to : 

● Assess the most critical area in case of 
evacuation

● Adapt the assembly points capacity 

● Check if the evacuation routes are sized with 
the traffic 

Manual beach’s users count method offer precise 
information on variation of the number of visitor on 
a hourly basis. 

Limitations : 

● Time consuming 

● Need a high observation spot 

● Limited to few beaches depending on the 
number of surveyor

Lesson #3 Graph theory & pedestrian network Coastwave 2.0 Evacuation 
Mapping Workshop 

Example of spatial data enrichment of the initial grid

Trémélo et Robert, 2023

Number of users at the Ponchettes beach, Nice, the friday 17 Jully 
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Example of spatial data enrichment of the initial grid

Using high resolution imagery (10-20 cm res.) for 
frequentation study allow to collect data for a larger 
number of beaches. 

High resolution imagery  was provided by IGN (BD 
Ortho, 2014) :

April 23, 2014 between 10:30 and 10:50 
June 5, 2014   between 14:00 and 15:00.
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Example of spatial data enrichment of the initial grid

As part of the EVACTSU project, photo-interpretation 
work was used to reference all visible individuals, 
vehicles and boats in the evacuation zone of Nice’s 
metropole. 

A total of 7,659 people were visible : 
○ ~ 5 000 were counted on the beach 
○ ~ 2 000 outside of the beach 
○ ~ 300 people in the sea

Those data were used to provide : 

● A snapshot of human frequentation for the 
whole coastal area of Nice Metropole.

● The number of people per assembly points 
for this specific evacuation scenario. 
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Example of spatial data enrichment of the initial grid
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Example of spatial data enrichment of the initial grid
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Example of spatial data enrichment of the initial grid
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Estimation of the number of 
residents within the tsunami 
evacuation zone, based on land 
registry data and aggregated by 
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Example of spatial data enrichment of the initial grid Aerial Survey Protocol for Counting Beach Users During 
Peak Attendance

● Three flights conducted around the weekend of 
August 15, 2021

● Aerial photographs taken of beaches across six 
departments: Pyrénées-Orientales (66), Aude (11), 
Hérault (34), Gard (30), Bouches-du-Rhône (13), and Var 
(83)

● 1,762 geolocated images

● Manual counting of people on the beach and in the 
bathing area across 27 beaches or beach sections

● Digitization of studied beaches as polygons in a GIS 
environment

● The time of flights was set between 3:00 PM and 4:30 
PM, corresponding to the peak beach attendance 
period according to the literature

Location of photos 
taken during beach 
overflights
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Example of spatial data enrichment of the initial grid
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Douvinet & Pierre Foulquier. « 
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Number of beach users 
extrapolated from aerial images, 
and aggregated by municipality.
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Example of spatial data enrichment of the initial grid

Changes in visitor numbers at the Croisette public beach (Cannes) on Saturday, July 30, 2022
between 10am (photo A) and 9pm (photo B).  (Carles N., 2024)
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Example of spatial data enrichment of the initial grid

Spatial join to 
enrich the 
hexagonal grid 
with building data 
(number of 
buildings, number 
of housing units). 
Use "Largest 
overlap" to avoid 
double counting — 
or convert 
polygons to points 
first.
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Example of spatial data enrichment of the initial grid

Number of housing units

Number of buildings

Université Montpellier Paul Valéry - LAGAM    Dr. Matthieu Péroche (matthieu.peroche@univ-montp3.fr) - Louis Monnier 
25

Tsunami evacuation routes calculation using graph-based 
GIS methodology

mailto:matthieu.peroche@univ-montp3.fr


Lesson #3 Graph theory & pedestrian network Coastwave 2.0 Evacuation 
Mapping Workshop 

Generate the starting points for accessibility analysis
1. Generate the starting points using the Features to point tools.

Feature to Point tools generate a 
point on every feature’s centroid. 
Due to previous clipping 
processing, “Inside” parameter 
must me activated in order to 
avoid generating external points : 
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Accessibility analysis 1/2 : Setting the analysis database 
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Accessibility analysis 1/2 : Setting the analysis database 

In order to realize a accessibility analysis, ArcgisPro require all layers (starting point, network, and assembly point) that will be used 
to be gathered in a single  database.

Geodatabase
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Accessibility analysis 1/2 : Setting the analysis database 

The graph must be added to the geodatabase then build

Geodatabase Network Graph
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“The closest facility solver finds one or more facilities that are closest 
to an incident based on travel time or travel distance and outputs the 

best routes between the incidents and the chosen facilities.”
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Accessibility analysis 2/2 : Launching Network Analysis

Top ribbon > Analysis > Workflow>Network Analysis

Be sure that your network graphe is set as the network Data 
Source

In our case, the facilities will be our assembly points, and the 
incidents will be the starting points.
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Accessibility analysis 2/2 : Launching Network Analysis

Top ribbon > Closest Facility Set search direction toward assembly points

N → 1 relation 

Expected result : 

Assembly points Starting points
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Accessibility analysis 2/2 : Launching Network Analysis

Click on Run to compute 
the shortest routes 

Change the routes symbology for a better 
understanding of the algorithm’s output : 

● Feature Layer > Symbology
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How to explore data? 
What improvements can be made?
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Output’s correction and data’s exploration

Add  the field “Travel_time” to the routes layer. 
(Data Type = Double)

The travel speed is set at 4,9 km/h. For this exemple, 
we won’t weigh the travel speed.

Other informations can be computed to 
enhance the discussion with to authorities 
during the validation process. 

i.g : Assembly point mean elevation  
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Improving the road network to better match actual pedestrian use

Most of the networks available for download are 
intended for vehicular traffic, therefore, it can lack 
accuracy for pedestrians dedicated ways :

● Beach access

● Park’s entrances / exit

● Unreferenced tracks (often 
the case along the coast or 
in wooded areas)

● Staircase

● Underground pedestrian 
crossing path

● Docks …

Original network

Missing 
pedestrian ways
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Improving the road network to better match actual pedestrian use 

Network must be completed manually by vectorizing 
all the missing pedestrian ways, using satellite 
imagery and field mission.

Double check is recommended for every 
new features created.

Once the network is complete, its topology must be 
checked and corrections made for sections that are not 
cut at intersections, in compliance with topology rules.

Connecting new features to 
the original network require 
to split lines where they 
intersect in order to be used 
as a graph.

Arcgis Pro provide a build-in 
vectorisation tools (Split) that 
automatically split lines on 
their intersection.

Exercice : 

Complete the network layer  
with all the missing pedestrian 
ways and check for existing 
topology errors.

Try the following edition 
tools (Top ribbon > Edit > 
Tools) :

- Split
- Line intersection
- Explode
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Why Configure the Pedestrian Network?
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Slope (%) Travel speed (m/s)
< 3 1,3485

[3-6[ 1,2644
[6-9[ 1,1823

[9-12[ 1,1023
[12-15[ 1,0245
[15-18[ 0,9491
[18-21[ 0,876
[21-24[ 0,8054
[24-27[ 0,7373

≥ 27 0,4751

Example of travel speeds according to network gradient. (Péroche, 2016)

Graph Configuration Parameters

● Edge orientation: force walking direction (e.g. one-way paths, stairs)

● Edge weighting: define travel cost based on:

○ Slope (walking slower uphill)
○ Road hierarchy (main roads vs minor paths)
○ Surface type (paved, gravel, dirt, stairs)
○ Width and condition of each segment

Why Use Graph-Based Analysis?

● Allows testing of multiple evacuation scenarios

● Provides credible travel time estimates over the actual network
 → Without accounting for congestion effects

● Identifies difficult or constrained areas in the network

● Adapts to different walking profiles:
 → Elderly, children, reduced mobility, responders

● Supports comparison between evacuation options
 → Shortest path vs fastest path, route capacity, alternative access
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What simple parameters with available data?
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✅ What We’re Doing

● We’ll use a limited number of walking speeds

● Speeds will be assigned based on:

○ Type of segment (e.g. road, path, stairs,..)
○ Surface material (paved, unpaved, etc.)
○ Width of the segment

⚠ What We’re Not Doing (and Why)

● Slope will not be included in this demonstration
 → It requires extra processing for very minimal time 
differences

 → Especially in the Cannes, where:

○ Evacuation distances are short (often < 400 m)
○ Slope has limited impact on total evacuation time
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Assigned Walking Speeds Based on Segment Type and Width

Segment Type (NATURE) Condition (Width if needed) Assigned Speed 
(km/h)

Remarks

Type autoroutier / Bretelle — 0 Not walkable (excluded)

Escalier / Sentier — 2 Slow speed due to difficulty

Chemin / Route empierrée / Rond-point / Piste cyclable — 3.5 Moderate walking speed

Route à 1 chaussée Width < 5 m or 
unknown

3.5 Narrow or undetermined width

Route à 1 chaussée Width ≥ 5 m 5 Standard road, comfortable pace

Route à 2 chaussées — 5 Large road, good walkability

Other (default) — 3 Default speed for unclassified 
segments

Step 1 - define travel speed conditions
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Add a new field in 
the network layer to 
store walking 
speeds (km/h)

Assign values based on 
segment type and 
width, using IGN 
attributes (Sample 
Arcade Expression )

Step 2 - Create a New Attribute Field and Implement Walking Speeds

Assigned Walking Speeds Based on Segment Type and Width

1

2

if (nature == "Type autoroutier" || nature == "Bretelle") {
    return 0;
}
if (nature == "Escalier" || nature == "Sentier") {
    return 2;
}
if (nature == "Chemin" || nature == "Route empierrée" || nature == "Rond-point" || 
nature == "Piste cyclable") {
    return 3.5;
}
if (nature == "Route à 1 chaussée") {
    if (IsEmpty(largeur) || largeur < 5) {
        return 3.5;
    } else {
        return 5;
    }
}
if (nature == "Route à 2 chaussées") {
    return 5;
}
return 3;

Université Montpellier Paul Valéry - LAGAM    Dr. Matthieu Péroche (matthieu.peroche@univ-montp3.fr) - Louis Monnier 
41

Tsunami evacuation routes calculation using graph-based 
GIS methodology

mailto:matthieu.peroche@univ-montp3.fr


Lesson #3 Graph theory & pedestrian network Coastwave 2.0 Evacuation 
Mapping Workshop 

Compute travel time in 
minutes for each segment 
based on the segment’s 
length and walking speed 

Formula (Field Calculator – 
Python syntax)

0 if !Walk_Speed! == 0 else (!SHAPE_LENGTH! / 
1000) / !Walk_Speed! * 60

Explanation

● !SHAPE_LENGTH! is in meters

● !Walk_Speed! is in km/h

● We convert meters to kilometers, then hours to minutes

● If the speed is 0, the travel time is set to 0 (non-walkable segment)

Step 3 – Calculate Travel Time on Each Segment

Assigned Walking Speeds Based on Segment Type and Width

1

2

Add a new field in 
the network layer to 
store Travel Time 
(min)

1

3
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Lesson #3 Graph theory & pedestrian network Coastwave 2.0 Evacuation 
Mapping Workshop 

Recalculate and compare results.
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● Time-optimised evacuation routes are identified in 
order to facilitate the fastest evacuation from 
starting points within the tsunami evacuation zone 
toward a designed tsunami assembly point. 

● In order to obtain this result, it is necessary to set up 
the road network accordingly.

● The walking speed parameter must be set for each 
network's edge, in order to accurately reflect the 
impact of their physical characteristics (e.g. nature 
and width) on walking speed.

Lesson #3 Graph theory & pedestrian network Coastwave 2.0 Evacuation 
Mapping Workshop 

Main result used specifically for tsunami evacuation maps
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Lesson #3 Graph theory & pedestrian network Coastwave 2.0 Evacuation 
Mapping Workshop 

Output’s correction and data’s exploration
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Lesson #3 Graph theory & pedestrian network Coastwave 2.0 Evacuation 
Mapping Workshop 

Output’s correction and data’s exploration

We can compute statistical summary 
(min, max and mean travel time …) from 
our routes layer and join the values for 
both assembly points and starting 
points.
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Lesson #3 Graph theory & pedestrian network Coastwave 2.0 Evacuation 
Mapping Workshop 

Output’s correction and data’s exploration

We can compute statistical summary (min, max and mean travel time 
…) from our routes layer and join the values for both assembly points 
and starting points.

1. Open routes attribute table > Top ribbon > Table

2. Launch Summarize Statistics two time (Using both 
FacilityID and IncidentsID as grouping fields) 

Statistical summaryNumber of routes 
pointing to the 
assembly point
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Lesson #3 Graph theory & pedestrian network Coastwave 2.0 Evacuation 
Mapping Workshop 

Output’s correction and data’s exploration

We can compute statistical summary (min, max and mean travel time 
…) from our routes layer and join the values for both assembly points 
and starting points.

1. Open Facilities attribute table > Top ribbon > Table

2. Select Join 

3. Join the Facilities and the facilities statistic table 
using features Id as key values

4. Do the same for the Incidents
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Lesson #3 Graph theory & pedestrian network Coastwave 2.0 Evacuation 
Mapping Workshop 

Output’s correction and data’s exploration

Problem : 

One route is generated for each starting points, which result in a difficult to read 
output

They must be dissolved into one feature using the field FacilityID as the key.
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Lesson #3 Graph theory & pedestrian network Coastwave 2.0 Evacuation 
Mapping Workshop 

Output’s correction and data’s exploration

By merging feature based on a shared attributes, the dissolve tool can induce error in segments orientation. 

In order to simplify the manual corrections easier, we need to split the dissolved routes with the planarize tool (Top ribbon > 
Edit > Tools). Less manual splitting operation will be required 

 

Université Montpellier Paul Valéry - LAGAM    Dr. Matthieu Péroche (matthieu.peroche@univ-montp3.fr) - Louis Monnier 
50

Tsunami evacuation routes calculation using graph-based 
GIS methodology

mailto:matthieu.peroche@univ-montp3.fr


Lesson #3 Graph theory & pedestrian network Coastwave 2.0 Evacuation 
Mapping Workshop 

Output’s correction and data’s exploration

Changing segment’s orientation is done manually. This step is also an opportunity to control the generated routes. 

Two editing tools will be 
needed : 

● Split
● Edit vertices

Split
Edit vertice
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Lesson #3 Graph theory & pedestrian network Coastwave 2.0 Evacuation 
Mapping Workshop 

Output’s correction and data’s exploration

Removing or adding evacuation routes segment is often necessary 

All routes must be inspected in order to guarantee that : 

1. Once a route has left the evacuation zone, it cannot pass through it 
again.

2. Allow leaving the evacuation zone as quickly as possible.

3. Allow to get away from coast as quickly as possible.
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Field inspection can be organized during 
tsunami exercices (tsunami walk), recruiting 
scholars, students, general public … 

+ Vérification des temps d’accès 
+ Difficultés pratiques liées au terrain 

Tsunami evacuation routes calculation using graph-based 
GIS methodology
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Other result useful for tsunami evacuation planning 

Lesson #3 Graph theory & pedestrian network Coastwave 2.0 Evacuation 
Mapping Workshop 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● Evacuation flow zones for each tsunami assembly 
points can be identified once the network analysis 
has been conducted.

● The grid from which the starting points are derived 
allow a clear representation of the evacuation flow 
zone for the stakeholders.

● This grid is the basis upon which additionals 
geo-indicators will be built on, in order to provide 
meaningful insights to help the decision-making 
process. 

R

Tsunami evacuation routes calculation using graph-based 
GIS methodology
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Evacuation flow zone for each assembly points
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Other result useful for tsunami evacuation planning 

Lesson #3 Graph theory & pedestrian network Coastwave 2.0 Evacuation 
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● This cartographic result shows the time required to reach 
a refuge site on foot from each grid of the territory. It 
shows the areas where these times are longest, and 
therefore the sectors most at risk in the event of a tsunami.

● Set against the estimated time of arrival of the wave, this 
result reveals the risk hotspots. It guides planning choices: 
adjusting routes, increasing or relocating refuge sites.

● In the most critical areas, targeted actions can reduce 
travel times: lane openings, adapted equipment, better 
signage. Depending on the seismic context and 
topography, vertical evacuation solutions may also be 
considered when horizontal evacuation is not sufficient. 

Tsunami evacuation routes calculation using graph-based 
GIS methodology

This is travel time, not full evacuation time, 
which also includes at least warning and 
reaction time.

Evacuation travel time to reach tsunami assembly point 
(minutes)
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● Data aggregation on the road network 
can be conducted to visualize the spatial 
distribution of evacuation flow 

● Therefore, in order to underpin this 
analysis,  it is necessary to produce or 
obtain data regarding the spatial 
distribution of human population (e.g 
number of residents, beach’s occupancy, 
with seasonal or daily variation).

● This cross-analysis allow for representation 
of theoretical number of people who are 
expected to use  a specific evacuation route.

Lesson #3 Graph theory & pedestrian network Coastwave 2.0 Evacuation 
Mapping Workshop 

Université Montpellier Paul Valéry - LAGAM    Dr. Matthieu Péroche (matthieu.peroche@univ-montp3.fr) - Louis Monnier 
55

Capture d’écrans : 
- Aggrégation sur le réseau routier 

- Cumul théorique de personne à évacuer par 
tronçons routiers 

Other result useful for tsunami evacuation planning 

Tsunami evacuation routes calculation using graph-based 
GIS methodology

Example of a data aggregation on network segments. Based on the data 
from this exercise, it shows a number of housing.
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Other result useful for tsunami evacuation planning 
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● Theoretical number of people expected on a 
tsunami assembly point is most of the time 
requested by the local authorities.

● The subsequent analysis provides support for the 
production of this geo-indicator. 

● This final result can be achieved for a worst case 
scenario, or, depending on the available data, can be 
conducted for multiples scenarios, e.g :

■ Seasonal variation in the tourist population 
(high and low saison) 

■ Day and night population variation on the 
most exposed area (e.g beaches)

■ Specific events (e.g festival, ceremony, sport 
events …)

Tsunami evacuation routes calculation using graph-based 
GIS methodology

Theoretical number of housing expected on each assembly 
point
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Lesson #4 

Lesson’s overview

Graphical semiology and map layout

1. Theory 2. Practice

● Arcgis pro’s layout composer

● Single map layout

● Atlas / Map series layout

Coastwave 2.0 Evacuation 
Mapping Workshop 

2

Produce a set of easy-to-understand maps covering the entire study area 

● Information displayed on an 
evacuation map

● Symbolisation

● Map scale 
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Diversity of designs in tsunami evacuation map 

Lesson #3 Graph theory & pedestrian network Coastwave 2.0 Evacuation 
Mapping Workshop 

From Kurowski and al, 2011

3

Lesson #4 Graphical semiology and map layout Coastwave 2.0 Evacuation 
Mapping Workshop 

From Girres and al, 2018
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Girres, J. F., Leone, F., Péroche, M., Gustave, G. 
& Gherardi, M. (2018). Analysis of tsunami 
evacuation maps for a consensual 
symbolization rules proposal. International 
Journal of Cartography 
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Information displayed on evacuation map

Lesson #3 Graph theory & pedestrian network Coastwave 2.0 Evacuation 
Mapping Workshop 

Most tsunami evacuation maps include :
 
● Hazard / evacuation zone

● Safe zone

● Assembly points (or areas)

● Evacuation guidance (general direction or 
evacuation routes)

Within this frame, differents choices can be made for : 

● Symbolisation

● Color scheme

● Scale

● Textual informations 

● Basemap

From Kurowski and al, 2011 4

Lesson #4 Graphical semiology and map layout Coastwave 2.0 Evacuation 
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Lesson #3 Graph theory & pedestrian network Coastwave 2.0 Evacuation 
Mapping Workshop 

From Kurowski and al, 2011

Differences in : 

● Scale

● Color scheme 

● Assembly 
points/area symbol

● Infrastructure 
information 

● Terrain information 

5
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Information displayed on evacuation map

Lesson #3 Graph theory & pedestrian network Coastwave 2.0 Evacuation 
Mapping Workshop 

6

From a scientific research project, the EXPLOIT project (2016-2018) in the 
French West Indies proposed a cartographic chart for evacuation plans which, a 
decade later, has become a standard in France.

EXPLOIT

EVACTSU Mayotte
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Information displayed on evacuation map
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From a scientific research project, the EXPLOIT project (2016-2018) in the 
French West Indies proposed a cartographic chart for evacuation plans which, a 
decade later, has become a standard in France.

EXPLOIT

EVACTSU Mayotte

Lesson #4 Graphical semiology and map layout Coastwave 2.0 Evacuation 
Mapping Workshop 

The strength of this standard has been based on an analysis of 
global best practices, its graphic consistency with ISO tsunami 
signage standards, and the fact that the plans have been tested 
with local stakeholders and the population during exercise such as 
CARRIBWAVE.
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Information displayed on evacuation map
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Map Canvas

Overview 
map

Scale bar & north 
arrow

Legend

8
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Layout
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Information displayed on evacuation map

Lesson #3 Graph theory & pedestrian network Coastwave 2.0 Evacuation 
Mapping Workshop 

Map produced by the LAGAM 
(Montpellier’s geography and urban 
planning laboratory) include :

Graphical infomations
 
● Safe zone 

● Evacuation zone 

● Evacuation routes

● Assembly points 

● POI

Textual informations

● Assembly points names

● Toponymy 

9
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● Simplicity and explicitness are key in symbols 
choices, especially for the evacuation related 
information displayed on a map. 

● For symbols with multiples colors, they should be 
chosen with a high contrast level.

● High-contrast color choices must take into account the 
superimposition of other (surface) symbols.

● Transparency use is limited to evacuation zone and 
safe zone in order to display the basemap with 
elevation shading.

Symbolisation

Lesson #3 Graph theory & pedestrian network Coastwave 2.0 Evacuation 
Mapping Workshop 

Graphic choices for symbols must allow for a clear and quick understanding of the map information. 

For Nice’s metropol, multiple 
variations of the symbol  evacuation 
route were proposed to represent 
underground sections, bridges and 
staircases;

Girres and al, 2016

10
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Map scale
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Scale must be chosen accordingly to match data’s accuracy and the purpose of the map :

● Information / sensibilisation map 

● Decision making support 

● Operational use 

● Field mission

1:5 000

1:10 000

1:20 000 11
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Arcgis pro’s layout composer
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Go to Top Ribbon > Insert > New Layout and select a page size (A3 landscape) 

Content panel

Map & Atlas management Map’s layout element Layout element

Add a map to your canvas 

Set guides to frame your layout
Rigt click on the ruler > Set 
multiples guides

Map scale & Display zoom

12
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Arcgis pro’s layout composer
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Set your map canvas extent : 

1. Right click on your map > Activate (Q)

2. Pan and set the scale with mouse 
wheel or with the bottom ribbon.

3. Click on Layout to return to layout 
edition

Make sure that all the the evacuation 
routes pointing  to an assembly point are 
visible in the map extent.

13
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Single map layout
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- Add the map’s legend

Legend’s 
elements

Legend model 

Legend’s properties

14
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Single map layout
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You can customize legend’s behavior and legend’s appearance either 
at a global level or at element’s level.

Access the legend’s properties panel directly in the layout or in the 
Contents panel through 4 menus  :

Right click > Properties

15

● Map connection
● Title
● Layers orders synchronisation 

with the map

● Automatic column and font size adjustment
● Word wrapping
● Spacing between legend elements

● Border
● Background
● Shadow

● Position 

General text symbol (font type, 
size, color, decoration ….) 
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Université Montpellier Paul Valéry - LAGAM    Dr. Matthieu Péroche (matthieu.peroche@univ-montp3.fr) - Louis Monnier 

mailto:matthieu.peroche@univ-montp3.fr


Item

Single map layout
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Patch

Appearance can be changed for a specific elements, or multiple 
elements at once : 

Option 1 : 

Select either one, multiple or all legend’s element in content pane > 
Right click > Properties

Option 2 (for all legend elements) 

In the legend’s properties panel > Legend items > Show properties
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Layer’s name

Label (or layer’s name by default)

Symbol size

Text 
element’s 

display 
option

Display 
order
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Change the appearance of your legend in order to match this layout : 

 

Single map layout
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Element labels can be set in the symbology menu of the corresponding 
layer. 

● If no label is set, the layer’s name is displayer by default.
● Description can also be shown in the legend.

Contents panel > Map Frame > Right click on the layer > Symbology
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You can save your legend’s style or any element’s style to 
use it in another project or to use it by default : 

Contents panel > Right click on Legend > Save to style

1. Set the label for each layer

2. Set a bigger patch size for every legend’s elements

3. Set the legend’s spacing
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Université Montpellier Paul Valéry - LAGAM    Dr. Matthieu Péroche (matthieu.peroche@univ-montp3.fr) - Louis Monnier 

mailto:matthieu.peroche@univ-montp3.fr


Single map layout
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Like the legend, the north arrow and scale bar are connected to a map frame. They adapt 
dynamically to changes in the map's scale or orientation, and fitting strategies can therefore 
be used to determine how these elements respond to changes.

Numerical scale can be added via Top Ribbon > Dynamic text

18

Division numbers

Division mark Subdivision mark

Maps unit

Add the north arrow and scale bar to the layout to match the layout below. Align these 
two elements with each other and the page. 

 
1. In the Scale Bar Properties panel, 

set the map unit in meter and change 
the label position

2. Set the division value to 250

3. Change marks frequency and 
reduce the subdivision’s mark 
height 

Try out the different fitting 
strategies available and adjust the 
map scale to see how the scale 
bar reacts.

Lesson #4 Graphical semiology and map layout Coastwave 2.0 Evacuation 
Mapping Workshop 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Single map layout
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Overview map are used to display main map’s context. The main map’s extent is often shown with a shape marker.

Since the overview map’s frame is smaller, we need to create a map with less layers in order to ensure readability     
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1. Top ribbon > New Map

2. Rename it in Overview map in the Contents 
panel

3. Choose a minimalistic basemap : 
Top ribbon > Map > Basemap

4. Add Cannes administrative boundaries and 
the evacuation zone layers
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Single map layout
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1. Go back to the Layout tab

2. Click on Map Frame and choose the 
overview map

3. Add it to your layout 

4. In the Extent indicator option, choose Map 
Frame

5. Set the overview map extent and scale

6. In the Contents panel, select the Extent 
Indicators > right click > Properties

7. Customize the extent indicator to make it 
stand out
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Single map layout
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Labels are text elements used to display an attribute’s value for each layer’s feature. Assembly point name must be labelled on the 
evacuation map. 

● In the Contents panel, select the Assembly point 
layer.

● Top ribbon > Labelling

● In the Label Class menu> Field, select the 
assembly point name’s field (nom_p)

● Activate labelling with Label in the Layer menu

● Customize label’s appearance and position by 
expanding the Text Symbol menu

● Advanced position parameters are available to set 
preferred placement, display order and label’s 
fitting strategies (world wrap, abbreviation field, 
number of lines ….) 
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Single map layout

Using ESRI’s basemap 
automatically add credits in our 
map frame. 

Add a Dynamic text > Service 
Layer Credits in order to control 
their position and style

 

At this point, almost all the elements 
synchronized with our main map are 
set up. 
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Add a title to our map  and 
logo (1_Original_data folder) in 
the layout’s bottom ribbon
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Atlas / Map series layout

As part of the EVACTSU - Nice Côte d’Azur project, 76 tsunami 
evacuation maps were generated using maps series tool. 

Lesson #4 Graphical semiology and map layout Coastwave 2.0 Evacuation 
Mapping Workshop 

Atlas (QGIS) or Map series (ArcGIS) are 
automatically generated series of pages from a 
single layout, with each page showing a different 
extent.

Dynamic elements such as data table, chart or 
dynamic text can be added to the layout and will be 
updated for each pages.

The map series extents can be set : 

● From layer’s features geometry (spatial)

● From bookmarks (spatial)

● From a set of layers (thematic) 
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Using a index layer to set the extents allows 
to use fields to :

- Set a name for each extent, which can 
be accessed via dynamic text.

- Control the order in which the page will 
be generated

- Group the pages based on field’s value

- Set custom scale for each extent 

Lesson #3 Graph theory & pedestrian network Coastwave 2.0 Evacuation 
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Atlas / Map series layout

Map series extents will be set up from an index layer :  map_series_extent (1_Original_data) : 

This layer can be built manually or 
automatically generated with build-in tools 
when working on larger area :

● Grid Index Features (Creates a grid to 
cover an extent)

● Strip Map Index Features (Creates 
polygons along a linear features e.g : 
coastline) 
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Atlas / Map series layout

Index layer’s fields

Each entity must be named after a known location

● Neighborhood

● Landmark (airport, plaza)

● Natural feature (cap, island) 

A numerical field can be added to set the map scale 
for each extent.

When working with multiple municipalities, a 
dedicated field should be added to group the map 
series pages on municipalities name.
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Activate Map Series from the Layout tab or Layout’s 
properties in the content panel.

1. Choose the map’s frame to which the map 
series will apply.

2. Select the Index layer 

3. Select the name and sort fields

Lesson #4 Graph theory & pedestrian network Coastwave 2.0 Evacuation 
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Atlas / Map series layout

The map extent can be set in a variety of ways :  

● By setting a margin around index feature’s 
geometries.

● With  constant scale for all map series pages.

● Dynamically from each feature using a scale field

Since the polygons of the index layers are not all 
the same size, a dynamic map extent setting must 
be chosen.
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Once a map series is activated, you can select wich page will be displayed on your the page’s layout.

Contents panel > Select List Map Series Pages 
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Atlas / Map series layout
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The index layer doesn’t require to 
be displayed in order for the map 
series to be activated
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Atlas / Map series layout
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Map series allow to set up dynamic text elements to display layer, project or 
layout’s specific information, i.g :

● Attribute table
● Field value
● Author / Date / Metadata
● Scale

To insert Dynamic text : 

Layout tab > Top ribbon > Dynamic Text 

Add the page name on your layout :
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Atlas / Map series layout
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You can combine static and dynamic text within one text element.

Dynamic Text preset can be edited : 

Select your dynamic text element > Right click > Properties

1. Remove the static text “Page Name:” and 
keep only the “name” tag

2. Choose another pertinent dynamic text 
element to add to your layout

The size of the dynamic text element will be adjusted 
based on the length of the page name, which may 
result in it overlapping with other layout elements.
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Atlas / Map series 

layout
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Result : 
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In many cases, basemaps 

provided by ESRI  doesn’t display 

all the information needed.

⇒  Cultural / Political / 

Administrative basemap 

doesn’t include terrain 

information
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Atlas / Map series 

layout

Lesson #4 Graphical semiology and map layout Coastwave 2.0 Evacuation 
Mapping Workshop 

Basemap : OpenStreetMap 
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In many cases, basemap 

provided by ESRI  doesn’t 

provide all the information 

needed.

⇒  Terrain basemap doesn’t 

include buildings or landmark.

At the scale of our evacuation 

plans, only the most important 

sections of the road network are 

displayed. 
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Atlas / Map series 

layout
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Basemap : Terrain with labels
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Atlas / Map series layout
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Terrain elevation must be displayed on tsunami evacuation map. The most commons ways to provide this information are contour 

lines and hillshade.

In your map’s tab > Top ribbon > Map > Add Data > Data

In the Add Data window, select Living atlas and search for 

“Hillshade”

Arcgis don’t allow to add multiple basemap on a single map, 

but the tiles or imagery layers used in the basemaps can be 

imported as standalone layer, allowing to compose your own 

basemap.
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In order to display both OpenstreetMap basemap and the World Hillshade tile layer, transparency and / or blending mode 

should be adjusted. 

Select the World Hillshade layer > Top ribbon > Tile Layer > Effects
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Atlas / Map series layout
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In order to display both OpenstreetMap basemap and the World Hillshade tile layer, transparency and / or blending mode 

should be adjusted. 

Select the World Hillshade layer > Top ribbon > Tile Layer > Effects

Everytime a layer is added to the map, the legend is updated. 

In the Layout tab > Content > Legend > uncheck the World Hillshade tile 
layer
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Atlas / Map series layout

One of the map extent need a layout set on portrait mode
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How would you solve this problem ? 
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Atlas / Map series layout
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Exporting a map series : 

Layout tab > Top ribbon > Share > Export Layout

The Properties menu allows you  to set the file format, 

export resolution and destination folder. 

1

1 2

The Map Series menu allows you to choose which 

pages will be exported, and whether they will be 

exported as independent files or as a single file.

2
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Lesson #5 

Lesson’s overview

Dynamic cartography - Support for evacuation map diffusion
Coastwave 2.0 Evacuation 

Mapping Workshop 

2

Create a web map using Arcgis online tools  
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Coastwave 2.0 Evacuation 
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● Upload geospatial & non-spatial data 

● Access to your organization’s content or community’s content

● Publish map and application 

● Perform spatial analysis

● Connected with Arcgis Pro Desktop

● Collaborative work 

Arcgis Online is ESRI’s cloud GIS platform. It’s fully integrated in 
ESRI’s software ecosystem and provides all the necessary tools / 
services, from spatial analysis to content publishing : 
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Web interface for : 

● Data’s management

● Web map 

● Web app 

● Collaborative work 
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Organization’s library 
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Work group management 
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Upload, configuration and authorisation management for sharing.
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Coastwave 2.0 Evacuation 
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Access to a wide range of web applications : 

● Mapping : Map Viewer, Scene Viewer (3D), Vector style editor

○ Create interactive 2D or 3D map 

○ Custom basemaps 

○ Perform spatial analysis*

● App creation : Storymap, Experience builder, Instant App

○ WYSIWYG interface for web site creation 

○ Integration of others ESRI’s web app 

○ User oriented application

○ Audience 

● Data collection : Field map designer, Survey123

○ Conduct survey and perform result’s analysis

○ Collect data on the field and cloud’s 
synchronisation
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Storymap :  EVACTSU Mayotte 
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Storymap :  TASOMA
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Embed geographic content with interactive elements. 

“
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Public Access and Download of Evacuation Maps
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Dynamic data visualization 
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User oriented application 
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Uploading data to Arcgis Online - Option #1 (Project export)
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Uploading data to Arcgis Online - Option #1 (Layer export)
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Uploading data to Arcgis Online - Option #2 (Online interface)

Vector data must me 
compressed (.zip, .7z) before 
import in Arcgis Online 

● Database connection

● Feature layer

○ Vector format 

○ Geotagged pictures

● Tile imagery 

● Arcgis 3D scene

● Web App

● Geocoding library

● PDF file
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Uploading data to Arcgis Online - Option #2 (Online interface)
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Upload attachment to a web layer 
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Upload attachment to a web layer 
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Contact :  matthieu.peroche@univ-montp3.fr

Lesson #6
Tsunami evacuation signage



IOC Manuals and Guides, 74.Paris, April 2022English only

The most visible way to educate the public about 

the tsunami hazard in the coastal zone is by using 

signboards. The tsunami signage will contribute to 

public awareness of the risk posed by tsunamis and 

better understanding of what should be done by the 

community in response to the event. It is critical 

that residents and tourists be aware of tsunami 

hazard zones, evacuation routes and safe zones in 

coastal areas.

� Signage needs to comply with national and/or international 
standards specifications.

� Signage must inform both the local population and 
international visitors.

� Local or national authorities have to define the number of 
signs by localities, but at a minimum, there must be signs for 
public education and signage for evacuation

� The adoption of a tsunami signage standard will provide a 
basis for a consistent set of signage and symbols nationwide.
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http://itic.ioc-unesco.org/index.php?option=com_content&view=article&id=1645&Itemid=2322

https://www.iso.org/obp/ui#iso:grs:7010:E063

In 2008, the International 
Organization for Standardization (ISO) 

approved international signage for 
tsunami hazard zones, evacuation 
areas and evacuation buildings. 

ISO 20712 on water safety signs and 
beach safety flags provides guidance 

on safety signs that provide 
information about aquatic hazards and 

the action necessary to avoid those 
hazards, including signage for tsunami 

hazard areas.
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http://itic.ioc-unesco.org/index.php?option=com_oe&task=viewDocumentRecord&docID=28111

CARIBE EWS Tsunami Signage Inventory and Report
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The first tsunami evacuation signs in the French West Indies (Martinique, 2013)
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https://exploit.univ-montp3.fr/
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The ISO-approved signage consists of three signs : 

• Tsunami Evacuation Building 
(right) - To indicate the location 
of a safe building for evacuation 
in the event of a tsunami 

Tsunami Hazard Zone (left) - 
To warn of a hazard from 
tsunami waves 

• Tsunami Evacuation Area 
(middle) - To indicate the 
location of a safe place/uphill 
area for evacuation to in the 
event of a tsunami 
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https://oceanexpert.org/downloadFile/6200

The ISO-approved signage consists of three signs : 
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Adaptation of the international tsunami hazard signage (ISO 20712 standards) – TSUNAMI EVACUATION ZONE

Download link : https://exploit.univ-montp3.fr/5-ressources.html
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Adaptation of the international tsunami hazard signage (ISO 20712 standards) – EVACUATION ROUTE

Download link : https://exploit.univ-montp3.fr/5-ressources.html
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Adaptation of the international tsunami hazard signage (ISO 20712 standards) – SAFE LOCATION

Download link : 
https://exploit.univ-montp3.fr/5-res
sources.html
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https://exploit.univ-montp3.fr/
data/RESSOURCES/Panneaux/C
harte_panneaux.pdf

Download link : 
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Tsunami evacuation exercise 
Middle School of Robert 2016
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Present-day situation in FWI 
Guadeloupe island
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Present-day situation in FWI 
Martinique island
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Example of files issued to communes (A: plan of sign locations 
for an evacuation route; B: ready-to-print signs for an 

evacuation route)

Present-day situation in FWI 
Martinique island
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Present-day 
situation in FWI – 
Saint-Barthélemy 

island
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Blue lines on Island Bay streets show tsunami-safe zones

New Zealand's famous "blue line" would become "green line“ in Saint Barthelemy !
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https://arcg.is/1jKCv50

Interactive version of evacuation plan 

✔ Mapping of the area to be evacuated and quantification of the main issues in 
this area (population, critical infrastructures, etc.)

✔ Identification of horizontal refuge sites and evacuation routes according to a 
scientific protocol adapted from work carried out in the Caribbean

✔ Mapping of evacuation plans according to a standardised graphic chart

Extract of an evacuation plan – (2021)
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✔ Suggested signage to be installed along evacuation routes 

Tested signage (ground paint), august 2020

Information and public survey stand, august 2020

Different supports and materialss
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• Identify the location of evacuation signage 
based on existing evacuation plans

Some key steps
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• Identify the location of evacuation signage 
based on existing evacuation plans

• Produce a photographic report of the 
signage location

Some key steps
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• Identify the location of evacuation signage 
based on existing evacuation plans

• Produce a photographic report of the 
signage location

• Produce maps showing the signage locations  

Some key steps
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• Identify the location of evacuation signage 
based on existing evacuation plans

• Produce a photographic report of the 
signage location

• Produce maps showing the signage locations  

• Draft the technical file / the mock-ups for 
the selected company.

Some key steps
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● The sign dimensions should be 
discussed with both the stakeholder and 
the selected company. 

● Standard dimension signs cost less and 
are faster to produce. 

Some key steps
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• Identify the location of evacuation signage 
based on existing evacuation plans

• Produce a photographic report of the 
signage location

• Produce maps showing the signage locations  

• Draft the technical file / the mock-ups for 
the selected company.

• Guide the company on site for installation 

Some key steps
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• Identify the location of evacuation signage 
based on existing evacuation plans

• Produce a photographic report of the 
signage location

• Produce maps showing the signage locations  

• Draft the technical file / the mock-ups for 
the selected company.

• Guide the company on site for installation 

• Map the installed signage

Some key steps
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• Identify the location of evacuation signage 
based on existing evacuation plans

• Produce a photographic report of the 
signage location

• Produce maps showing the signage locations  

• Draft the technical file / the mock-ups for 
the selected company.

• Guide the company on site for installation 

• Map the installed signage

• Communicate to media

Some key steps
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Of all the criteria to be recognized as IOC-UNESC Tsunami Ready, 

the installation of tsunami signage is the most difficult: 

� Signage and its installation are costly

� Signage materializes the spatial extent of the risk 

� Signage requires several levels of approval (administrative, 

financial, legal, etc.), and the process can be lengthy.

IOC Manuals and Guides, 74.Paris, April 2022English only

Two French experiences:

#1 Importance of following the pictograms and colors proposed by 
the ISO standard to create a national standard.

#2 Allow some flexibility in the choice of signage supports and 
materials to encourage stakeholders to adopt the system.
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WELCOME to Montpellier !

CoastWAVE 2.0 Project 

IOC-UNESCO (EU DG ECHO)

January 14-15, 2024

30 June – 4 July 2025



Welcome to University Montpellier Paul Valéry Coastwave 2.0 Evacuation 
Mapping Workshop

2

Founded in 1970, UMPV builds on a legacy dating back to 1289 in 
Montpellier.
Multiple campuses in Montpellier & Béziers
Route de Mende campus is a listed 20th-century heritage site!

At UMPV :
➢ 23,000 students
➢ 774 faculty & researchers
➢ 1,335 guest lecturers
➢ 654 admin & tech staff
A vibrant and diverse academic community!

The Saint-Charles site is UMPV ’s research hub in the heart of 
Montpellier.

ATRIUM, new Learning Center

21 interdisciplinary research units

Big changes at Route de Mende !

Discover ATRIUM, our brand new Learning
Center — a bold architectural project in a green
campus.

A gateway between
knowledge and society !



Welcom to our Research Lab : LAGAM ! Coastwave 2.0 Evacuation 
Mapping Workshop
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Founded in 2021, the LAGAM – Geography and Spatial Planning
Laboratory of Montpellier – is a university research center dedicated to
applied geography, spatial planning, and risk management. Affiliated
with Paul-Valéry University Montpellier 3, it builds on over 20 years of
scientific expertise.

LAGAM bridges fundamental research and operational action, with core
skills in:

Action-research, spatial analysis, cartography, modeling, geomatics,
and drone-based aerial surveys.

With 80 members, including 30 PhD students and 25 affiliated
researchers, LAGAM is a dynamic hub, closely linked to the geography
degree programs at the university and internationally oriented.

Follow our research, fieldwork, and projects!
https://lagam.xyz/

➢ Natural hazards, crises & disasters
➢ Transport & mobility
➢ Emerging challenges in urban planning
➢ Spatial analysis, mapping & modeling
➢ Coastal & water management
➢ Coastal & applied geomorphology
➢ Health & territories
➢ Rural development and trajectories
➢ Public policy & local development in Europe

A gateway between
knowledge and society !

Research focus areas:



Context History of Tsunami Risk Projects Coastwave 2.0 Evacuation 
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TSUNARISQUE

2009 2010 2011 2012 2013 2014 2015 2016 2017 2018 2019 2020 2021 2022 2023 2024 2025 20262008200720062005

Indonesia

2004

Areas where our team has worked

Project name

Dir. Franck Lavigne / Raphaël Paris

http://www.editionsdelasorbonne.f
r/fr/livre/?GCOI=28405100100000

https://www.youtube.com
/watch?v=4QeZA-6DB04
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TSUNARISQUE MAREMOTI

2009 2010 2011 2012 2013 2014 2015 2016 2017 2018 2019 2020 2021 2022 2023 2024 2025 20262008200720062005

ASTARTE

Indonesia Morocco Italy
Morocco

2004

Areas where our team has worked

Project name

PREPARTOI

Mayotte/Réunion 
(Indian Ocean)
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TSUNARISQUE MAREMOTI

2009 2010 2011 2012 2013 2014 2015 2016 2017 2018 2019 2020 2021 2022 2023 2024 2025 20262008200720062005

ASTARTE

Indonesia Morocco Italy
Morocco

2004

Areas where our team has worked

Project name
Péroche M., Phd

Martinique (F.W.I)

PREPARTOI

Mayotte/Réunion 
(Indian Ocean)
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TSUNARISQUE MAREMOTI

2009 2010 2011 2012 2013 2014 2015 2016 2017 2018 2019 2020 2021 2022 2023 2024 2025 20262008200720062005

EXPLOIT : https://exploit.univ-montp3.fr/

ASTARTE EXPLOIT

Indonesia Morocco Italy
Morocco

French West 
Indies

2004

Areas where our team has worked

Project name

Martinique (F.W.I)

PREPARTOI

Mayotte/Réunion 
(Indian Ocean)

Péroche M., Phd

https://exploit.univ-montp3.fr/
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TSUNARISQUE MAREMOTI

2009 2010 2011 2012 2013 2014 2015 2016 2017 2018 2019 2020 2021 2022 2023 2024 2025 20262008200720062005

TASOMA : https://arcg.is/0ifqmH

EVACTSU Mayotte : https://arcg.is/1be4iC0

ASTARTE TASOMA

Indonesia Morocco Italy
Morocco

French 
Mediterranean

EVACTSU

2004

EVACTSU MNCA

CoastWave 2.0

Areas where our team has worked

Project name

Nice 
Metropolis

Mayotte 
(Indian Ocean)

Nice & 
Marseille

EXPLOIT

French West 
Indies

Martinique (F.W.I)

PREPARTOI

Mayotte/Réunion 
(Indian Ocean)

Péroche M., Phd
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History of Tsunami Risk Projects
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Deshaies municipality

(Guadeloupe, F.W.I)

30 juin 2023 

Cannes municipality

19 janvier 2024



… a Perspective from Montpellier

➢ A deeply formative experience — humanly and scientifically.

➢ A call to action: risk prevention, evacuation planning, and research in action.

Time from hazard modeling to evacuation planning

(a reality check across contexts):

✓ Mayotte → 8 years

✓ French Antilles → 10 years

✓ Cannes (France) → 18 years

Context
Coastwave 2.0 Evacuation 

Mapping Workshop

11

Over 20 years:

➢ 11 research projects (national & international)

➢ 5 PhD theses

➢ 40 master’s theses (GCRN master degree)

➢ 80 + communities with validated tsunami 

evacuation plans

Scientific progress must be 

translated into action !

20 Years of Tsunami Risk Work… 
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Matthieu Péroche – Phone number : 

0033684773759

Researcher, LAGAM

Tsunami evacuation mapping · ICG 

CARIBE-EWS & NEAMTIC · Crisis planning

Louis Monnier

Research Engineer

GIS modeling · CoastWAVE 1 & 2 · 

Workshop design & facilitation

Frédéric Leone

LAGAM Director – Professor

Post-disaster analysis · Field deployment · 

Scientific coordination

Monique Gherardi

Research Engineer

Stakeholder engagement · Co-

construction methods · Operational tools

Lyna

Geography undergraduate student (L2)

Workshop support · Local logistics · 

Training immersion

Emilie Lagahé

Research Engineer

Cartographer, scientific development and 

knowledge dissemination
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What you’ll learn this week

1. Delineating evacuation zones

2. Identifying assembly points

3. Building pedestrian network graphs

4. Calculating travel times & optimizing routes

5. Designing clear, accessible evacuation maps

Day 1 – Context & Introduction

• Welcome, overview of CoastWAVE 2.0

• Tsunami hazard modelling (CEA)

• Icebreaker

Day 2 – Defining Safe Zones

• Evacuation zone mapping

• Identifying assembly points

Day 3 – Evacuation Routing

• Graph-based network construction

• Time-efficient route calculation

• Start cartographic design

Day 4 – Map Production

• Graphical semiology & layout

• Static and dynamic maps

Day 5 – Applying the Method

• Tsunami signage & field application

• Group work on case studies (if time permits)

• Wrap-up

Workshop
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Workshop

Room H227
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